# CAD Manual Appendices

## Table of Contents

**Introduction** .......................................................... 1

**Appendix 1: Working With Point Groups** .......................................................... 1

**Appendix 2: Working With Sheet Set Manager** .................................................. 3

- Introduction ........................................................................ 3
- Creating a New Sheet Set ............................................. 3
  - Explanation of Sheet Set Properties: .............................. 5
- Creating Sheets .................................................................. 7
- Creating XREF Views .................................................... 10
- Creating Viewports ......................................................... 17
- Creating a Sheet Index ................................................... 21
- Publishing ......................................................................... 23
- Placing Callout Blocks for Detail/Sheet Cross-Referencing. ................................................. 24
- Update Barcodes on Record Drawing Sheets .................................................................. 27

**Appendix 3: Markup, Measure and Compare with Autodesk Design Review** ............... 29

- Markup Protocol .................................................................. 29
- Drawing Comparisons ......................................................... 29

**Appendix 4: Grading Tables** ................................................................................. 31

- Point Label Styles .......................................................... 31
- Point and Point Label Layers .......................................... 32
- Point Numbering Setup ................................................... 33
- Create Points ....................................................................... 34
- Create Tables ....................................................................... 37

**Appendix 5: Creating Classified Linework** ............................................................ 39

- Multiline Setup .............................................................. 39
  - Creating Multilines ......................................................... 40
- Creating Classified Objects ............................................. 40
- Filling in Data ...................................................................... 42
Appendix 6: Pay Items for Quantity Take-Offs .......................................................... 43
  Design Drafting .................................................................................................. 44
  QTO Manager .................................................................................................. 45
  Pay Items ......................................................................................................... 47
  Formulas .......................................................................................................... 50
  Compute Quantity Takeoff ............................................................................... 55

Appendix 7: Vertical Asset Data ........................................................................... 61
  3D Models ........................................................................................................ 61
  Equipment Property Sets .................................................................................. 62
  Insert Equipment Schedule ............................................................................... 66

Appendix 8: Strategic Approach to Utility Profiles ............................................. 68
  3D Pipes .......................................................................................................... 69
  Utility Crossings .............................................................................................. 69
  Presentation (Printable) Linework in Profiles .................................................... 70
Introduction

The CAD Manual Appendices have been written to provide helpful information in support of the CAD Manual. The content in the appendices are not standards, but tips and information to help achieve the standards defined in the CAD Manual.

This document contains Autodesk® AutoCAD® and Autodesk® AutoCAD® Civil 3D® usage tips and instructions which are for reference only and are not a replacement for formal training. Contact an Autodesk® Certified Instructor for training opportunities.

Appendix 1: Working With Point Groups

As a standard practice, a “_No Display” point group is created along with various other groups under the “Point Groups” section in the Prospector tab of the Toolspase (command: SHOWTS).

To change the display of points in a drawing, right-click on “Point Groups” and select “Properties...”
Point groups are displayed based on hierarchy. Whatever point group is on the top takes priority over all other point groups under it. If “_No Display” is on top, no points will be displayed in the drawing.

Move a point group to the top to see the points contained within that group.
Appendix 2: Working With Sheet Set Manager

Introduction
Sheet Set Manager (SSM) is a powerful tool in AutoCAD. SPU & SDOT use SSM to ensure consistency in every sheet as required by our CAD standards. Here are some helpful tips for using SSM.

Creating a New Sheet Set
Start up Sheet Set Manager one of the following ways:

- Click on this button:
- Type SSM in the command line.
- Ctrl+4
- Select the pull-down menu: Tools → Palettes → Sheet Set Manager

Create a new sheet set by selecting the down-arrow in Sheet Set Manager and selecting “New Sheet Set...” (see following picture).
Create a new sheet set using an example sheet set (see following picture).

Click “Next >”. Select a sheet set to use as an example (see following picture). The COS_SheetSet should be the only option if you set your template paths correctly using the instructions on the first page.

Click “Next >”.

City of Seattle CAD Manual Appendices
Fill out the form with your project name, description and the sheet set storage location (see following picture).

Click the “Sheet Set Properties” button to add more information about your project to the sheet set.

**Explanation of Sheet Set Properties:**

**Sheet Set (skip)**
This section will be filled in for you already. You can skip this section.

**Project Control (if applicable)**
Fill in the project number, name, phase and milestone (if applicable). The milestone field will be displayed on the lower left corner of every title block in the sheet set. For example, when your project is approaching the 60% design milestone, in the milestone field type 60% DRAWINGS. Every sheet will display this label.

**Sheet Custom Properties (skip for now; add to individual sheets)**
This contains the default settings for creating new sheets, but will not change settings for existing sheets. For example, if there will be only one drafter for every sheet in the project, fill in the drafter’s initials in the appropriate field and every sheet that is created from that point on will contain those initials by default. If you are not sure what changes will be made in the future, leave this section as-is. You can change these properties on a sheet-by-sheet basis in the future.

**Sheet Creation (skip)**
This section will be filled in for you already. You can skip this section.
Sheet Set Custom Properties (project information)
This section contains the global settings for your entire sheet set. You should fill in most of the fields in this section. The data in these fields will show up on all the title blocks in this sheet set.

Click OK when you are done.

Click “Next >” and you will see a summary of the sheet set you just created. Click Finish.
Creating Sheets

Right-click on the sheet set and select “New Sheet...” (see following picture).

Fill in the “Number” and “Sheet title” boxes. The “File Name” box will automatically be filled in for you. The “Sheet title” should follow the standard file naming convention.

NOTE: See CAD Manual for standard file naming convention.

Your new sheet will now appear under the sheet set. Right-click on the new sheet and select “Properties...”
Edit the “Description” and other “Sheet Custom Properties”:

The “Description” field will show up as green text in the lower-right corner of the sheet.

When finished hit OK.

Double-click on the sheet to open it and then select the correct titleblock:

1. You will see this:

   ![Select SPU or SDOT titleblock]

2. Click on it to reveal hidden grip:

   ![Select SPU or SDOT titleblock]

3. Click the grip to select titleblock:

   ![Select SPU or SDOT titleblock]

As in the pictures above, click on the box to select either the SPU or SDOT titleblock.
You will see a title block with fields already filled in for you based on the properties of the sheet set and the sheet (see following picture).

NOTE: If you right-click on the sheet set or the sheet and edit the properties, you will need to “REGEN” the drawing to see the changes in the drawing.

If you need to display a profile grid on a sheet, simply thaw the layer called C-ANNO-GRID (you may need to REGEN). A profile grid block with attributes will appear. Simply double-click on it to edit the left and right elevation attributes. When you overlay an XREF of a profile drawing in model space and create a viewport on the grid, you can align the profile elevations with the profile grid block elevations by selecting the viewport box and snapping one of the XREF’s elevations perpendicular to the appropriate profile grid block elevation. Then set the XREF’s profile grid & elevation layers to not plot.
Creating XREF Views

Open one of your sheet drawings through SSM that you want to add a view to. Set the G-VIEW-FRME layer current and draw a rectangle (command: RECTANG) where you want the view to go. It doesn’t have to be perfect as the viewport can be adjusted later. WBLOCK the rectangle out and name it something like “ViewFrame-Full.dwg” (delete it from the drawing). Open an XREF containing your linework and insert your newly created view frame block into it.

When inserting this view frame you can specify the scale you will want to see in your viewports (see following picture). If you will be printing your drawing at 20-scale, set the scale to 20. If you will be printing at 100-scale, set it to 100. And so on...
Insert the view frame using the Nearest OSNAP on an alignment.
Then, using another Nearest OSNAP, drag and click on the alignment to align the view frame with the alignment (see following picture).
If you want to move the view frame edge to align with a specific station, you can move the view frame at the intersection (OSNAP) of the frame edge and the alignment, and snap it to a station using the Insert OSNAP (see following picture).

If you only need one view, then you’re done. If you need more than one view, from this point on, you can either repeat the steps above to insert another view frame, or you can copy the current view frame as many times as you need.
Next you need to align your UCS with the first view frame. To do this type UCS on the command line. Then type OB (for OBJECT) and select the bottom of a view frame (see following picture).

Then type PLAN on the command line and hit Enter twice.
To create a view, simply type V (command: VIEW) and click the “New...” button create a new view (see following picture).
Give the view a name and type a category name (optional). Make sure you uncheck the “Save layer snapshot with view” checkbox (see following picture).

Click the “Define window” radio button to set your view. Snap, using the END or INT OSNAP, to the corners of the view frame.

Then hit Enter to accept the window definition.

Repeat the steps above to create more views.

**NOTE:** Be aware that if your view frames rotate, you may need to re-align the UCS with every view.
Creating Viewports

In Sheet Set Manager select the “Model Views” tab and double-click on “Add New Location...” (see following picture).
Browse to the location where your XREF files are located and click the “Open” button. The “Browse for Folder” dialog box will appear blank even though drawings exist in the folder (see following picture).
If xrefs are stored in more than one location, add another location by following the same procedure shown above (see following picture).

Click the + icon next to the XREF name to reveal the views contained in the drawing (see following picture).

Right-click on a view name and select “Place on Sheet” (see following picture).
Right-click to set the scale of the viewport (see following picture).

You will notice that it automatically puts the XREF in model space, creates a viewport box and inserts a view title.

**WARNING:** Be aware that Sheet Set Manager automatically “freezes” all other layers in that viewport. If you want anything else to show in that viewport you will need to “thaw” layers in that viewport.

**CONCEPT:** When placing a plan view on a sheet such as a base map, generally you will want to show another XREF (such as a water or drainage design) on top of it. To do this, you do not need to follow the process above and place another view in the sheet. All you need to do is go into Model Space and overlay an XREF. However, you must be aware of the warning above about layers frozen in that viewport. If you overlay an XREF and it doesn’t appear in the viewport, check your layers and thaw them in that viewport.

**At this point you need to change two objects to the correct layer:** Change the viewport box to the G-VIEW-FRME layer; and switch to model space and change the XREF to the correct layer (X-****).
Creating a Sheet Index
To create a sheet index on the cover sheet, first open the cover sheet drawing. Then in Sheet Set Manager on the “Sheet List” tab, right click on the Sheet Set (top item) and click on “Insert Sheet List Table…” (see following picture).

You will get a dialog box that looks like this:
The required columns are “Sheet Number”, “Sheet Title” and “Description” fields:

Click OK to insert the sheet index on the cover sheet. When you add, delete, renumber, rename, or edit the description of any sheets, you need to update the table. To do this, right-click on the table and select “Update Table Data Links”.
Publishing
Open COS_SheetSet.dwg and right-click on the “Plot” tab and select “Page Setup Manager...” Create page setups for your plotters, and then save and close the template file.

To publish (plot) a set of plans in your sheet set, in the Sheet List tab of Sheet Set Manager right click on the sheet set and select Publish → Publish using Page Setup Override → [select a page setup override].

This will plot all the sheets in your sheet set according to the settings in the page setup that you selected. Please note that the page setup overrides will only work if you have the plotters installed correctly on your computer.

NOTE: When creating/editing page setups in the template (DWT file), you must set the “Plot area” to either Layout or Extents. SSM will ignore page setup overrides with plot areas set to Display or Window.

To setup/modify a Page Setup Override for your plotters/printers, simply right-click on your sheet set and select:

Publish → Manage Page Setups...
This will open up the Page Setup Manager for the DWT template file. Generally we setup our plot areas to Extents and select the “Center the plot” checkbox. But we realize that sometimes it is easier to use a different plot area such as Display or Window. When first creating your page setup, it is ok to use Display or Window plot areas, but because SSM doesn’t support those plot areas you will eventually need to change it back to Layout to be usable in SSM.

For example, if you find it easiest to setup the plot area with “Window”, go ahead and do so. Hit ok in the Page Setup dialog box to save it. Then modify your Page Setup again and change it from Window to Layout. The Layout plot area will maintain the same plot area previously set by the Window plot area and it will now be usable as a Page Setup Override in SSM.

**Placing Callout Blocks for Detail/Sheet Cross-Referencing**

Here is an example of our standard method of cross-referencing between sheets and views:

![Callout Block Diagram]

It is important that you number your views in Sheet Set Manager. This enables you to cross-reference between views and sheets using callout blocks that contain Sheet Set Manager fields. To number your views, click on the Sheet Views tab, expand the sheet to see the views, and right-click to select “Rename & Renumber...” (see following picture).
Here is an example of renaming and renumbering a detail view:

![Renaming and Renumbering an Electrode View](image1)

Notice in this example of detail view, it has been numbered as 1 and the title contains %%44 to represent a comma.

“Number” section views with letters, and all other views with numbers. For example, a Section A-A will be numbered with the letter A. When placing a section callout block, it will refer to the letter A and display the section view title properly.
Once your views have been named and numbered properly, you can place all kinds of callout blocks in any drawing. To place a callout block in a drawing, right-click on a view and select:

“Place View Label Block”, or...

“Place Callout Block” → [select a block]
Update Barcodes on Record Drawing Sheets

All sheets contain a barcode for indexing in the Engineering Records Center (ERC). When a sheet set is converted into a “Record Drawing” sheet set, the barcodes need to be updated to reflect this.

To do this, open the Sheet Set, right-click on the sheet set name at the top...

...and select “Properties…” Look for the “Barcode Modifier” field:
Simply add an A after the hyphen in the “Barcode Modifier” field:

<table>
<thead>
<tr>
<th>Sheet Set Custom Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>Barcode Modifier</td>
</tr>
<tr>
<td>Federal Aid Project No</td>
</tr>
<tr>
<td>Job Number - CO</td>
</tr>
</tbody>
</table>

Do this and all the barcodes in the entire sheet set will be updated next time you print.
Appendix 3: Markup, Measure and Compare with Autodesk Design Review

*Autodesk Design Review* is free software that you can use to view, print, markup, and measure drawings in DWF format. Click on the “Markup & Measure” tool:

![Autodesk Design Review Interface](image)

**Markup Protocol**

Illustrate with the following colors:

- **RED**: new/revised linework or text to be added/modified in the drawings
- **GREEN**: deletions
- **BLUE**: clarifying comments to CAD technician

**Drawing Comparisons**

To compare design changes between submittals, open a DWF in Design Review and select a sheet that you want to compare.

![Drawing Comparison Interface](image)

Go up to the “Tools” tab and click “Compare Sheets”.

![Compare Sheets](image)
Browse to find a DWF of the same drawing set, created at a different time. Then select the same sheet that you currently have open in Design Review.

If you want, you can change the default colors for things that were deleted or added between the sheets.

Final result is essentially an automatic markup of the DWF sheet showing what is new and what has been deleted.

(the sheet shown above was compared to a completely different sheet to show exaggerated differences)
Appendix 4: Grading Tables

It is often important to create a finish grade (proposed) surface when doing any kind of grading. If you create a surface, data for it can be automatically added to tables. Automated tables containing a station/offset and an elevation for each grading point are preferred in order to avoid mistakes. It might seem strange, but an easy way to accomplish this is to use Pipe Network structures and labels.

Point Label Styles

It is important to follow agreed-upon label formats for grading points. Here are a few:

- **General Grading:** $G\#$ (i.e. G1001 in a rounded rectangle)

- **Ramp Grading:** $R\#-X$ (i.e. R2-C in a rounded rectangle; for RAMP-2, point C)

- **Pond Grading:** $P\#-X$ (i.e. P2-A in a rounded rectangle; for POND-2, point A)

This label style (CG-SPOT) is available in the design drafting Civil 3D template.
Point and Point Label Layers

Before you get started run the **EDITDRAWINGSETTINGS** command, go to the Object Layers tab and change the Structure and Structure-Labeling layers to C-TOPO-ANNO.

![Diagram of Object Layers settings](image)

Essentially you are adding topo points instead of Structures and topo labels rather than Structure labels.
**Point Numbering Setup**

Before you start creating points, think about how they will be numbered. If you want to start your point numbers at 1000, then it will be easier to set this up instead of going back and renumbering later on. To set this up before creating a new Pipe Network, go to the Settings tab of Prospector (if not visible, use command: SETTING), expand Pipe Network and Commands, right-click on CreateNetwork and select “Edit Command Settings...”

Expand Default Name Format and edit the Structure Name Template.

Here is an example of grading points that start at 1000:
Create Points

In the Home tab of the Ribbon, select: Pipe Network → Pipe Network Creation Tools

Create a Pipe Network for each grading feature surface and name it so it is easily associated with the feature (the Network name will be displayed in the table title later). Select the parts list called CG-SPOT, choose the proposed grading surface, select an alignment nearby and use the CG-SPOT structure label style.

In the Network Layout Tools, expand “Spot Elevation” and select the “EDIT STRUCTURE DESCRIPTION” structure part.
Then add “Structures Only”.

Add the points and drag the labels so they are easy to read.

You can rename the structures in the Prospector tab of Toolspace (command: SHOWTS); this will automatically update the labels.

Also, you will need to edit the structure descriptions which can be displayed in the table. To edit a bunch of descriptions at once, select a few (using SHIFT or CTRL), right-click on the “Description” column header and select “Edit…”

Type a description, hit ENTER and all that were selected will change.
If you decide to change the numbering (going forward) for your points, right-click on your Pipe Network and select “Network Properties...”

Go to the Layout Settings tab and edit the name template for Structures.

You can click on the button to edit the name template...

...which allows you to change the starting number.

Going forward, new points you create for this Network will use this template and starting point.
You can also switch the referenced surface and alignment names in the Network Properties:

This will not change any points you have already created – only points you create going forward.

Create Tables

In the Annotate tab of the Ribbon, select: Add Tables → Pipe Network → Add Structure

Select the CG-SPOT table style and network (you may change other settings if you’d like) and click OK.
Appendix 4: Grading Tables

Click to add the table someplace in your model space. This table will automatically update if you modify the surface elevations or move the structures to a new location.

<table>
<thead>
<tr>
<th>POINT</th>
<th>ELEV</th>
<th>STATION/OFFSET</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>R2–A</td>
<td>56.41’</td>
<td>STA 14+44.00, 14.42’RT</td>
<td>TOP OF CURB</td>
</tr>
<tr>
<td>R2–B</td>
<td>56.26’</td>
<td>STA 14+39.58, 16.99’RT</td>
<td>FLOW LINE</td>
</tr>
<tr>
<td>R2–C</td>
<td>56.45’</td>
<td>STA 14+36.80, 19.87’RT</td>
<td>FLOW LINE</td>
</tr>
<tr>
<td>R2–D</td>
<td>56.93’</td>
<td>STA 14+34.08, 25.03’RT</td>
<td>TOP OF CURB</td>
</tr>
<tr>
<td>R2–E</td>
<td>56.67’</td>
<td>STA 14+43.71, 20.98’RT</td>
<td>TOP OF RAMP</td>
</tr>
<tr>
<td>R2–F</td>
<td>56.75’</td>
<td>STA 14+40.93, 23.86’RT</td>
<td>TOP OF RAMP</td>
</tr>
<tr>
<td>R2–G</td>
<td>56.71’</td>
<td>STA 14+47.33, 24.48’RT</td>
<td>BACK OF LANDING</td>
</tr>
<tr>
<td>R2–H</td>
<td>56.79’</td>
<td>STA 14+44.20, 27.02’RT</td>
<td>BACK OF LANDING</td>
</tr>
</tbody>
</table>

Utilize a viewport to display the ramp tables on a sheet.
Appendix 5: Creating Classified Linework

Section 6 in the CAD Manual says that we use Polylines to depict small pipes, Multilines to depict large pipes, blocks for standard fittings, instrumentation and structures, and closed Polylines for large/custom structures on civil plan drawings and all of these features must be classified.

First, let’s talk about Multilines.

Multiline Setup

Multilines may be used to draw pipes in 2D plans and profiles. The “design” Civil 3D template contains a lot of Multiline styles that represent standard pipe sizes. Type MLSTYLE to see the Multiline styles:

In this dialog box you can set a Multiline style current. Multiline styles are “closed” so you can easily add hatch patterns to them.
Creating Multilines
To create a Multiline, type MLINE in the command line. You will get this prompt:

Specify start point or [Justification/Scale/STyle]:

J for Justification
A picture says it all (clicking from left to right):

S for Scale
Don’t use this unless you need an exaggeration in a profile view.

ST for Style
Type the style name exactly as you created it. We have styles created for common pipe sizes. For example a 12" concrete pipe’s style would be named 12-CONC. An 18" ductile iron pipe’s style would be named 18-DIP.

Creating Classified Objects
The first step is to follow the “Best Practices for 2D Utility Drafting” steps in Section 6 of the CAD Manual. In summary:

1. Draw pipes invert to invert and match endpoints using OSNAPs.
2. Place blocks at 1-scale on pipes where required, using OSNAPs to ensure they are placed accurately.
3. Make sure layer names are correct and that all 2D linework elevations are at zero.
As an example, here is a storm pipe system drafted with Polylines, Multilines and blocks.

![Storm Pipe System](image)

Notice the Multiline has a hatch pattern inside, per Standard Plan 003h (see Section 6 of the CAD Manual for hatch pattern settings).

Once you have the linework drawn, it’s time to classify the objects. Attach the Object Class Definition File to your drawing by using the ATTACHDEF command. The `SPU-Object-Classification.xml` definition file is available online (See Section 2 in the CAD Manual).

To classify objects start the CLASSIFY command in Civil 3D.

![Classification Dialog](image)

Select the type of objects you are classifying (for example if you want to classify all the storm lines, select the “Storm_Drain_Lines” classification name) and click OK. A fast way to classify a bunch of objects is to select all the same type of objects first and then run the CLASSIFY command.
Filling in Data
If you select the pipes and go to PROPERTIES, you will see the data fields associated with the pipes.

You can fill out fields that are common for all the pipes all at once and the rest of the fields such as InsideDiameter, StartInvert and EndInvert can be filled in one-by-one.

Blocks only contain common fields that can be filled in all at once.

Closed-Polyline structures have one field called “Description” that is unique for each object.

The “User_ID”, “Date_Created”, “ACAD_Version”, “Milestone”, “CAD_KEY”, “FEA_KEY”, and “ASSETNUM” fields are to be filled out by SPU staff only. For more on filling in fields, see the “CAD-to-GIS” heading in Section 6 of the CAD Manual.

Once you are finished classifying objects and filling in the data, your drawing is ready to go through SPU’s QC process and be exported into GIS.
Appendix 6: Pay Items for Quantity Take-Offs

Bid items (known as “Pay Items” in Civil 3D) can be assigned to entities in AutoCAD Civil 3D. Once all the pay items are assigned, you can generate a report of the quantity take-offs. The types of objects that can have pay items assigned to them include Pipe/Pressure Networks, polylines, hatch patterns and blocks.

You can tell if a pay item is assigned to an object by the tooltip that appears when you hover over it.

This document will walk you through the process of drafting and assigning pay items to entities and generating reports that can be formatted and exported into other software.
Design Drafting
To design utilities, it is recommended that you use Pipe Networks for gravity systems and Pressure Networks for pressure systems. These are powerful tools that can give you control over your design.

If you need to draft something quickly and don’t need the power of Pipe/Pressure Networks, you can sketch utilities using polylines for pipes (unfortunately the use of Multilines is not fully supported at this time) and blocks for structures, instrumentation and appurtenances. Use the Custom Civil 3D Pull-Down Menu to set the correct layers; then draft utilities with polylines and blocks.

Areas such as clearing & grubbing, paving, soils, seeded lawns, etc. may be drafted using closed polylines and hatch patterns to define the area limits.

Other single items to be counted may be inserted as blocks or drawn as polylines, rectangles or circles.
**QTO Manager**

Once you have entities drawn in Civil 3D, open the QTO Manager panorama by clicking the “QTO Manager” button in the Analyze tab of the Ribbon. You can also type `QTOManager` in the command line.

If you don’t see “APWA Bid Items” in the list, click the folder icon dropdown and select “Open pay item file”.

The APWA pay item file (.csv), categorization file (.xml) and formula file (.for) can be downloaded from here: [http://Seattle.gov/util/CAD](http://Seattle.gov/util/CAD)
Expand “APWA Bid Items” to see the pay item categories.

Expand a pay item category to see the individual pay items.

You can turn the categorization on or off using this drop-down.
You can search for pay item names or numbers using the search bar.

If you find a pay item that you want to use frequently, right-click on it and select “Add to favorites list”.

Some pay items have formulas associated with them to calculate the correct quantity. You can edit/create your own formulas if needed.

Pay Items
You can assign one or more pay items to an object. For example you could add the following pay items to a single 12” PSD pipe: “PIPE, PSD, D.I., CL 52, 12 IN”, “BEDDING, CL B, 12 IN PIPE” and “MINERAL AGGREGATE, TYPE 17” (for backfill).

There are two ways of finding pay items in QTO Manager: expanding categories to browse or searching keywords to filter the list. To browse, click the little boxes next to each category to expand or contract them until you find the pay items you are looking for.
When searching, it is recommended that you turn off categorization first so it is easier to see the results.

If you want to assign a pay item like “PIPE, PSD, D.I., CL 52, 12 IN” to a pipe, search for it using keywords (such as “PSD”) or the pay item number to filter the large list of pay items down so you can find the one you want. Right-click on the pay item you need and select “Assign pay item”.
Select the object(s) you want to assign the pay item to and hit enter when finished. The command line will confirm that the pay item has been added and you can hover over objects to verify what pay items have been assigned.

If you choose “Assign pay item to area”, it will prompt you to select a point within a closed polyline to fill with a hatch pattern (and assign that pay item to it), select a closed polyline object to fill with a hatch pattern (and assign that pay item to it) or select a hatch pattern object (and assign that pay item to it).

If no hatch pattern exists, it will create a solid pattern on an incorrect layer but you can change the properties of it after it has been created. It is recommended that you select hatch pattern objects that are already in the drawing. Use the `ShowQTOCmdSettings` command to modify pay item area options.

**Unit Types**

Pay items with volume unit types will not show up in reports unless they have a formula that calculates the volume. For example, if you assign the planting soil pay item (which has a unit type of cubic yards) to a closed polyline, you will receive a warning in the event viewer stating as such.

To fix this problem, simply add a formula to the pay item to calculate the volume (see page 50).
Pay items with weight unit types must also have a formula associated with them to produce accurate values in the reports.

**Checking**
You can hover over each object one-by-one to verify what pay items have been attached or you can use a drop-down button in QTO Manager to highlight objects that have the selected pay items assigned to them.

You can also right-click on a pay item and select “Select objects with pay item”.

**Formulas**
You will need a formula for every pay item with a volume or weight unit type. By default, some pay items have example formulas; you can edit them and/or add your own. The formulas are yours to manage and are stored on your computer or network location in a .FOR file. When you add or edit a formula in QTO Manager, it updates your personal .FOR file. You can find a sample .FOR file here:

http://Seattle.gov/util/CAD

If you make a lot of edits or additions to your .FOR file, please make a backup of it so you don’t lose everything when updates happen (it may get overwritten). You can save your formula file in a private location and open it with QTO Manager.
In QTO Manager you can hover over an existing formula and a tooltip will appear showing the entire formula.

Click in a formula cell to open the formula expression editor for a pay item.

Use parentheses to control the order of operations. You can insert out-of-the-box parameters such as Item Area, Item Count, Item Length and Part Depth (this one only applies to Pipe Networks) or create your own to insert.

After you assign a pay item to an object, you can edit the formula for that object using the “Edit Pay Item on Object” button (or use the EditPayItemOnObject command). This gives you flexibility with formulas.
**Calculating Weight**

As an example, we will create a formula to convert Hot Mix Asphalt (HMA) areas to tons. To calculate the weight of material needed for a project you will need to know the compacted density of the material. Density is the weight of material per volume (for example, pounds per cubic foot). The density of HMA does vary depending on mix proportions and type of aggregate. If you do not know the in-place density of mixes you use, ask your supplier.

To determine the weight of material multiply the volume by the density of material:

\[
\text{Weight} = \text{Volume} \times \text{Density}
\]

Assuming an HMA density of 145 pounds per cubic foot (pcf) and a thickness of 2" we would perform the following calculations for a 5,000 sq. ft. paving area:

1. Volume = 5,000 sq ft × (2 in ÷ 12 in/ft) = 833 cu ft  
   (notice that the thickness was converted from inches to feet)
2. Weight = 833 cu ft × 145 lbs pcf = 120,785 lbs
3. Convert to tons = 120,785 lbs ÷ 2,000 lbs/ton = 60.4 tons

To write this as a formula, we would enter something like this in the expression editor:

\[
\frac{\{(\text{Item Area}) \times (2 \div 12) \times 145\}}{2000}
\]

Notice the use of parentheses to control the order of operations. This is very important.

Also you can see, that we inserted \( \text{Item Area} \) as a parameter in our formula.
You can create your own parameters by clicking the “Edit Parameters” button. For example, you could create a parameter for 2” thick HMA overlay.

You can then insert this parameter into your expression.

Custom parameters are saved in your formula file.
Calculating Volume

As an example we will calculate volume of Type 17 mineral aggregate used for trench backfill. Since this pay item will be assigned to an object representing a pipe, we can take advantage of the \{Item Length\} parameter in our formula.

We know, per Standard Plan 284, that the width of the trench varies depending on the pipe size.

Calculate the trench width and determine the depth of the Type 17 backfill to get the area. The area will be multiplied by the length (comes from the \{Item Length\} parameter) to get the volume in cubic feet. Multiply that value by 0.037037 to convert it to cubic yards.

With 3.33’ trench width and 2’ Type 17 backfill depth, your formula will look like this:

\((3.33 \times 2) \times \{\text{Item Length}\} \times 0.037037\)
You could also create a parameter to represent trench widths.

In this case the value of \( \{Sm \text{ Pipe Trench}\} \) is 3.33.

**Compute Quantity Takeoff**

To compute quantity take-offs, click the “Takeoff” button in either QTO Manager or the Analyze tab of the Ribbon. You can also type `TAKEOFF` in the command line and hit ENTER.
In the Compute Quantity Takeoff dialog box, you can create a summary or detailed report using the radio buttons at the top.

Generating sheet reports takes a lot of setup and is cumbersome to use but if you want to break down the data, break or create separate objects. Avoid using the alignment station range report option to compute reports because it is buggy and it has a tendency to drop length, area, volume and weight quantities out of the report.
To generate sheet quantities, you can break objects at sheet match lines and generate reports by selection sets (only select objects that appear on a sheet), but this can be difficult when utilizing Pipe Networks.

Click the “Compute” button to generate the report.
Appendix 6: Pay Items for Quantity Take-Offs

The quantity takeoff report may start off looking like it’s in XML format but you can change the format with the drop down at the bottom.

The HTML and TXT formats are easily readable. After you select a report format, click the “Save As...” button and save it to your project folder.
If you choose to “Save As” the report in HTML format, open it with Internet Explorer, right-click on the table and choose “Export to Microsoft Excel”.

<table>
<thead>
<tr>
<th>Pay Item ID</th>
<th>Description</th>
<th>Quantity</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>401217</td>
<td>204</td>
<td>112.19</td>
<td>CY</td>
</tr>
<tr>
<td>705058</td>
<td>204B</td>
<td>3</td>
<td>EA</td>
</tr>
<tr>
<td>717012</td>
<td>10 1/4 PIPE</td>
<td>229.667</td>
<td>LF</td>
</tr>
<tr>
<td>717662</td>
<td>12 IN</td>
<td>229.667</td>
<td>LF</td>
</tr>
</tbody>
</table>
If you choose to “Save As” the report in CSV format, it will save it as a comma-delimited text file.

In Windows Explorer you can rename the file to have a .CSV extension.

```
Summary (CSV).csv
```

Then double-click on it to open it in Excel for further editing.
Appendix 7: Vertical Asset Data

In AutoCAD Civil 3D, vertical assets are drawn as 3D solids or depicted as blocks with extended data attached to each object. This data can be used to create schedules and export into other applications. The AutoCAD Civil 3D design template (see Section 2 of the CAD Manual) has equipment property set definitions setup for this purpose.

3D Models

Vertical assets are generally designed using 3D objects—specifically 3D solid objects. You can acquire 3D models of equipment from manufacturers or sites like traceparts.com. 3D models come in many different formats, including DWG, ACIS (.SAT extension), SolidWorks (.PRT, .SLDPR, .ASM, .SLDASM extensions), 3D DXF and other 3D formats and can be opened natively or imported into Civil 3D using the IMPORT command.

To work with 3D models, switch to the 3D Modeling workspace to access the full suite of tools.

The goal is to end up with a 3D solid object of each piece of equipment or asset. If you build or receive a 3D solid model consisting of many solid parts, you can simplify it into a single object using the UNION command. This allows you to add data to a single object rather than one of many pieces.
Equipment Property Sets
Insert or draw equipment as 3D solids or blocks. Call out each equipment tag with a Multileader (command: MLEADER).

Start the AECAPPLYTOOLPSD command to attach a property set to each 3D solid (it is recommended to do this one solid object at a time). Click the “add property sets” button to attach the equipment properties to the 3D solid.
Select the “equipment” option and click OK.

Right-click in the “tag” attribute and select “insert field...”
Select the “object” field name and select the associated Multileader.
Select the “contents” property and click OK.

![Field selection screen]

Fill in the rest of the properties and click OK when finished.

![Property set definition]

Modify the Equipment property set definition using the STYLEMANAGER command.
**Insert Equipment Schedule**

Set **G-ANNO-TABL** layer current.

Start the **-SCHEDULEADD** command (include the dash at the beginning of the command) and follow the prompts:

Style name or [?] <Equipment>: EQUIPMENT

Layer wildcard <*>: *

Scan Xrefs? [Yes/No] <No>: N

Scan block references? [Yes/No] <No>: N

Add new objects automatically? [Yes/No] <No>: Y

Automatic update? [Yes/No] <No>: Y

Click to place the upper-left corner of the table in your drawing and hit enter to when prompted for the lower-right corner placement.
Right-click on the schedule table for additional configuration options. Blocks with a property set attached may need to be added to the schedule manually.

To modify the Equipment schedule style, including columns and the layout, use the SCHEDULE command and choose the STyle option.
Appendix 8: Strategic Approach to Utility Profiles

Typically, there are two parts to utility pipe alignments and profiles: pipe alignment/profile and survey control alignment/profile. Both are needed, and the survey control alignment profile is what is printed on the sheets.

The pipe alignment and profile are not printed but needed for design. The work done on the pipe alignment and profile can be superimposed or projected onto the survey control alignment profile.

Here are the basic steps:

1. **Create Control Profile Grid**: Create a profile view grid with a non-plotting profile grade line using the right-of-way control alignment. The purpose of this profile view grid is to project the pipeline features onto the grid so they align with the right-of-way stationing.

2. **Create Pipeline Profile Grade Line(s)**: Draw a non-plotting alignment that matches the pipeline geometry and create another profile view grid using the pipeline alignment. Existing and finish profile grade lines may be shown on this profile view grid. This profile is simply source data for the grade line(s) over the pipe geometry and may or may not be used for anything else.

3. **Superimpose Pipeline Grade Line(s) onto Control Profile Grid**: Superimpose the pipeline profile grade line(s) onto the right-of-way control profile view grid (command: SuperimposeProfile) to show the grade line(s) directly over the pipe. The end result is a hybrid profile showing grade elevations over the pipeline and stationing along the street control line. Civil 3D® Pipe Network parts and other 3D geometry (command: ProjectObjectsToProf) may be projected onto this hybrid profile.

There are some cases where pipes are best shown as true length along the pipe alignment in profile views. If the pipeline does not align horizontally with the plan view on a sheet, align one of the stations (preferably a major station, if possible) from the plan vertically with the same station in the profile (typically on the left-hand side of the sheet).
3D Pipes

Vertical pipeline data must be accurately represented as a Civil 3D® Pipe/Pressure Network or as a non-plotting Civil 3D® Profile with PVIs matching pipeline elevation points for clash detection and construction staking purposes. Here are two common approaches to creating 3D pipes:

1. **First Approach**: use the Pipe/Pressure Network tools to lay out pipes horizontally and vertically.
2. **Second Approach**: create a Civil 3D® Profile line* in the pipe alignment profile, generate an auto-feature line (command: CreateFeatureLineFromAlign) in the plan view and generate a Pipe/Pressure Network from it (commands: CreateNetworkFromObject or CreatePressureNetworkFromObj).

*the Civil 3D® Profile name should indicate the pipe location, size and if it represents the pipe’s invert or center line or top of pipe.

Once the 3D pipes are created, project them to the survey alignment profile using a non-plotting style (select the Pipe/Pressure Network objects and right-click to “draw parts in profile view”).

Utility Crossings

To add utility crossings, model them as 3D solids (if Pipe/Pressure objects are used, you will need to explode them into 3D solids using this command: convertto3dsolids) and follow the steps below to locate the crossing depths at the pipe alignment and project them to the survey control alignment profile. Here are the steps to find the 3D utility crossings:

1. **Make 3D Solids**: Model utility crossings as 3D solids (convert pipe objects to solids using this command: convertto3dsolids).
2. **Make Interference Object at Pipe Alignment**: Create a POLYSOLID that follows the pipe alignment and that is the width of the proposed pipe. Make sure the bottom and top of the POLYSOLID object is below and above the utilities, respectively.
3. **Create Intersectional Solids**: Find all the interferences (command: interfere) between the utility crossing 3D solids (first set) and the POLYSOLID (second set) and when you are finished keep the intersectional solids in your drawing.
4. **Place Crossings on Survey Control Profile**: Project the intersectional solids onto the survey control alignment profile (command: ProjectObjectsToProf).
Presentation (Printable) Linework in Profiles
See Section 4 of the CAD Manual for detailed presentation standards.

In profile views, draw the outside shape of maintenance holes and structures and draw pipes connected to the outside walls. Double-line proposed pipes are filled with hatch while maintenance holes and structures are not. Show exaggerated valve, fitting and blocking symbols if necessary. Show outlines of utility crossings and nearby structures.